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Welcome
[bookmark: _Toc211499420]Introduction 
[bookmark: _Toc211499421]Overview
Welcome to the SuperNova for Trainers Course Exercise and Reference Workbook. This workbook contains the exercises you will carry out during the Course.
If you have received this workbook without knowledge of the SuperNova for Trainers Course, please visit the Dolphin Learning Zone to find out more about this free course.
[bookmark: _Toc211499422]Workbook structure
This workbook is separated into exercises. Each exercise should be undertaken when prompted to do so during the SuperNova for Trainers Course.
Exercises may require you to:
Insert information in a table.
Complete missing words or phrases in a statement.
Answer theoretical questions.
Complete practical exercises using SuperNova Magnifier & Screen Reader.
Where applicable, answers to questions marked with a superscript number can be viewed at the back of this workbook. This workbook also contains a useful Hotkey Guide for future reference.
[bookmark: _Toc211499423]Download SuperNova Magnifier & Screen Reader
You are expected to download and install SuperNova Magnifier & Screen Reader onto a compatible system to complete the SuperNova for Trainers Course. This enables you to gain first-hand experience of the product.
If you do not have the latest version of SuperNova Magnifier & Screen Reader installed, please download and install a 30-Day Trial Version from YourDolphin.com.
[bookmark: _Toc211499424]Keyboard commands
As stated in the Course Overview webpage, this course uses keyboard commands. The keyboard commands in this course refer to the UK English keyboard layout. Keys for other layouts may not correspond exactly to the keys referenced.
Where keyboard commands are stated, a plus sign (+) means that you need to press multiple keys at the same time, for example, ALT + F means you must hold down the ALT key and while it is held down, press the F key before releasing both keys.
When a comma sign (,) appears in a keyboard command it means that you need to press the keys in sequence, for example, ALT, F means you tap the ALT key and then tap the F key.
To successfully complete this course, it is important to have a basic understanding of the keyboard layout and how you use the keyboard to operate Windows. If this is unfamiliar to you, we recommend you review the Keyboard shortcuts in Windows webpage, available from the Microsoft support website. 
[bookmark: _Toc211499425]Hotkey Sets
The lessons in this course reference two different hotkey sets: The hotkeys come from the two most popular hotkey sets used with SuperNova and Dolphin ScreenReader.
These are:
· The Desktop Default NumPad Set.
This hotkey set is based upon a standard Windows plug-in keyboard and makes use of both the numeric keypad and the main keyboard for its hotkey assignments. This is the most popular hotkey set.
· The Laptop Universal Set.
This hotkey set is based upon a standard inbuilt laptop keyboard layout, without a numeric keypad. It makes use of the main keyboard layout for its hotkey assignments.
If the instructions state only one hotkey, this means the keyboard assignment is the same in both hotkey sets.
You can review what hotkey set you are using in the SuperNova and Dolphin ScreenReader "Keyboard" dialog box.
To do this:
1. Run SuperNova.
2. Open the SuperNova or Dolphin ScreenReader Control Panel by pressing LEFT CONTROL + SPACEBAR.
3. Open the "General" menu, "Keyboard Settings" submenu and select "Keyboard" (Alt, G, K, K).

Lesson 1
[bookmark: _Toc211499426]Exercise 1
[bookmark: _Toc14093022][bookmark: _Toc23865770][bookmark: _Toc23946659][bookmark: _Toc211499427]Task - Editions
You learnt in this lesson that there are a total of four editions that make up the SuperNova and Dolphin ScreenReader product range. Each edition has its own feature set designed to meet the requirements of its target users.
[bookmark: _Hlk114143079]Below are a series of screenshots that show the Control Panel for each edition, plus a brief description of the key options presented in the screenshot.
Based on this information, please complete the table below.
Editions
Image A.
[image: Image A showing the SuperNova or Dolphin ScreenReader Control Panel]
Image A above shows the Control Panel with Visual, Speech, Braille, and Media tab options available in the Button Bar. 

Image B.
[image: Image B showing the SuperNova or Dolphin ScreenReader Control Panel]
Image B above shows the Control Panel with Visual, Speech, and Media tab options available in the Button Bar. The Button Bar does not include a Braille tab.

Image C.
[image: Image C showing the SuperNova or Dolphin ScreenReader Control Panel]
Image C above shows the Control Panel with Speech, Braille, and Media tab options available in the Button Bar. The Button Bar does not include a Visual tab.

Image D.
[image: Image D showing the SuperNova or Dolphin ScreenReader Control Panel]
Image D above shows the Control Panel with Visual and Media tab options available in the Button Bar. The Button Bar does not include Speech or Braille tabs.

Editions Table
	Screenshot
	Edition`

	Image A (1)
	


	Image B (2)
	


	Image C (3)
	


	Image D (4)
	



Tip: You can confirm the SuperNova and Dolphin ScreenReader edition and version number by selecting the "About" option in the "Help" menu of the SuperNova and Dolphin ScreenReader Control Panel.

Lesson 2
[bookmark: _Toc211499428]Exercise 2 
[bookmark: _Toc14093018][bookmark: _Toc23865766][bookmark: _Toc23946655][bookmark: _Toc211499429]Task – Control Panel
You learnt in this lesson that there are four main elements that make up the SuperNova and Dolphin ScreenReader Control Panel. It is important to know the correct terms for these elements and the keyboard commands that enable you to navigate the Control Panel.
Please fill in the missing words in the sentences below.
Control Panel elements and keyboard commands

[image: Dolphin ScreenReader Control Panel, displaying the speech tab options.]

[bookmark: _Hlk115862928]The Control Panel comprises four main elements. These are from top to bottom:

· T__________ Bar (5).

· M__________ Bar (6).

· B__________ Bar (7).

· S__________ Bar (8).

Pressing LEFT CONTROL + SPACEBAR opens the SuperNova and Dolphin ScreenReader Control Panel. When the Control Panel has focus, you can press:

· The A_____ k_____ (9) to move focus to the M__________ Bar (10).

· The TAB key to move focus across the B__________ Bar (11) objects.

· And CONTROL + T_____ (12) to open the next tab in the B__________ Bar (13).
 
[bookmark: _Hlk114559873]Lesson 3
[bookmark: _Toc211499430]Exercise 3
[bookmark: _Toc211499431]Task 1 - Magnification
You learnt in this lesson that you can adjust magnification using three methods. These methods are designed to support each user's preferred way of working in Windows. 
Please fill in the missing words in the sentences below and answer the questions.
Methods to adjust magnification
You can change the size of magnification in the following ways:

1.	Using the SuperNova C__________ P__________ (14).

2.	Using SuperNova k__________ c__________ (15). This method is also referred to as Hotkeys.

3.	Using t_______________ gestures (16).

Which single method would you promote to a client who prefers to use the keyboard to navigate the Windows interface?

	Answer (17):





Run SuperNova, increase your magnification size and consider at what level you feel a client may benefit from introducing speech support to help them work effectively.

	Answer (18):





Tip: You may find some clients who use magnification and whose sight has deteriorated, reticent about using speech alongside magnification. This is because clients may consider the introduction of speech as a confirmation of their continued sight loss. It is important to discuss the benefits speech offers, and emphasise to the client that they have control of the speech settings, so they can use it as and when it is required.
[bookmark: _Toc211499432]Task 2 - Panning
You also learnt in this lesson that SuperNova provides three ways to move the magnified window around your desktop.
These are:
· Using the mouse.
· Using touchscreen gestures.
· Using SuperNova Panning Mode.
Depending on your resources, run SuperNova and spend no more than five minutes reviewing the three methods you can use to move your magnified window across your desktop. 
Remember, panning is most useful at higher levels of magnification. You can start panning in a particular direction by holding down the RIGHT CONTROL key and tapping an Arrow Key. You can speed up movement by continuing to tap the Arrow Key and slow down movement by tapping the opposite Arrow Key. When you release the RIGHT CONTROL key, panning stops.
What occurs when you move the magnified window using Panning Mode to an area where the mouse pointer is out of view and then move your mouse?
A. Does the Mouse pointer appear in the centre of the magnified window at its current position?
Or,
B. Does the magnified window jump back to the mouse pointer position on the screen?

	Answer (19):





Tip: You can choose how the mouse pointer movement affects the magnified window by changing the state of the "Move mouse pointer into view" check box. This check box is in the "Tracking" tab of the "Visual Advanced Options" dialog box (ALT + V, A).
Lesson 4
[bookmark: _Toc211499433]Exercise 4
[bookmark: _Toc211499434]Task 1 – Creating a Hooked Area
You learnt in this lesson about the application, creation, and benefits of Hooked Areas. Now, spend no more than five minutes creating a Hooked Area to show the system clock. The system clock is positioned in the bottom right corner of the screen inside the Notification Area.
Position your Hooked Area at the top right corner of the magnified window with a magnification size of 3x.
Steps to create a Hooked Area
To do this:
1. Press LEFT CONTROL + NUMPAD 5 to create a new Hooked Area or, if you are using the Laptop Universal Hot Key set, press LEFT CONTROL + LEFT SHIFT + ALT + H.
You will be placed in Magnification Modification Mode, with a flashing border around the Hooked Area.
2. Use the Arrow Keys to position the Hooked Area on the screen. You can also do this by holding down the Z key and move the mouse.
3. Press LEFT CONTROL + Arrow Keys to adjust the size of the Hooked Area. You can also do this by holding down the X key and move the mouse.
4. Press LEFT SHIFT + Arrow Keys to alter the content inside the Hooked Area. You can also do this by holding down the C key and move the mouse.
5. Use the Increase and Decrease Magnification size keyboard commands to change the size of the content within the Hooked Area, for example, by using CAPS LOCK + MOUSE WHEEL UP or DOWN.
6. Press ESCAPE to save and exit Magnification Modification Mode. 
If, after exiting, you find your Hooked Area has disappeared, then press the Toggle Hooked Areas hot key. This keyboard command toggles between showing and hiding the Hooked Areas on the screen.
Press LEFT CONTROL + NUMPAD 3 or, if you are using the Laptop Universal Hotkey Set, press LEFT CONTROL + F5.
Does the appearance of Hooked Areas require the primary magnification View to be enabled?

	Answer (20):





[bookmark: _Toc211499435][bookmark: _Hlk114573784]Task 2 - Deleting a Hooked Area
Following on from the previous exercise, please fill in the missing keyboard commands that enable you to delete a Hooked Area. Then follow those steps to delete your Hooked Area.
Deleting a Hooked Area
To do this:
1. Press LEFT CONTROL + NUMPAD _____ (21) or, if using the Laptop Universal Hot Key set, press LEFT CONTROL + F6. 
2. If you have more than one Hooked Area, then continue to press the hot key until the Hooked Area you wish to delete has focus.
3. [bookmark: _Hlk115868985]Press the D__________ key (22) to remove the Hooked Area.
When the Hooked Area is deleted the next Hooked Area gains focus. If no Hooked Areas remain, then SuperNova automatically exits Magnification Modification Mode.

Lesson 5
[bookmark: _Toc211499436]Exercise 5
[bookmark: _Toc211499437]Task – Screen enhancements
You learnt in this lesson that SuperNova includes three features that aim to make your viewing of the computer screen more comfortable.
These are:
· Colour Schemes.
· Highlighting Schemes.
· Mouse Pointer Schemes.
The creation of a more comfortable viewing experience means people will be more productive in their work and suffer less eye strain, tiredness, and fatigue.
Please provide answers to the following user questions.
[image: A happy young man sat in front his laptop.]Questions


"I am using a desktop computer and I am struggling to view black text on a white background. I would prefer to view yellow text on a blue background. What Colour Scheme would you recommend? What hotkey enables me to turn this feature on and off?

	Answer (23):












[image: Young woman wearing glasses and head scarf typing on her laptop.]"I am finding it difficult to track the movement of my cursor as I navigate through the text in my document. What feature in SuperNova might help me identify the cursor position in my document?

	Answer (24):





[image: Man wearing headset is sat in font of a laptop and laughing.]

"I am using the Large Red Mouse Pointer Scheme but when I turn magnification off the mouse pointer changes to a standard mouse pointer. What setting should I change to prevent this behaviour?"

	Answer (25):




[image: A young woman wearing glasses and headphones looking at laptop screen.]

"I am considering purchasing SuperNova. I like the Colour Scheme and Highlighting Scheme options. Do these schemes continue to function when magnification is toggled off?"

	Answer (26):





Lesson 6
[bookmark: _Toc211499438]Exercise 6
[bookmark: _Toc211499439]Task – Multiple monitors
You learnt in this lesson that SuperNova includes support for multiple monitors. Based on the information provided in the lesson, please fill in the missing words in the sentences below.

Multiple monitor support
[bookmark: _Hlk115875900]Research claims that the use of multiple monitors can improve p__________. (27) However, users of magnification should ensure they can view all the monitors in a healthy and ergonomic way to avoid fatigue.
You should configure Windows to use the E__________ (28) Desktop option to make full use of SuperNova’s multiple monitor support.
When configured, you can use:
· S__________ M__________ (29) to create a single large desktop across the monitors.
· S____________________ M__________ (30) to position different applications on different monitors. In this mode, you can set different magnification sizes on each monitor.
· P__________ M__________ (31) to show an unmagnified PowerPoint slideshow on one monitor and your notes magnified on another monitor.
The M__________ B__________ (32) enables you to set a level of resistance between the monitors to prevent the mouse pointer accidentally slipping onto a secondary monitor when it reaches the edge of the screen.
And you can jump the mouse pointer from monitor to monitor by using the hotkey C__________ + M__________ M__________ B__________ (33).
[bookmark: _Hlk114731882]
Lesson 7
[bookmark: _Toc211499440]Exercise 7
[bookmark: _Toc211499441]Task 1 – Voice adjustments
You learnt in this lesson that SuperNova and Dolphin ScreenReader include a variety of adjustable speech parameters. The settings allow you to control the voice and its output.
Using the information provided in the lesson, please familiarise yourself with the following basic tasks. Add a tick in each cell to mark completion of the task.
Common speech parameter tasks
	Task
	Using Button Bar
	Using Menu Bar
	Using Keyboard Command

	Toggle voice on / off
	
	
	

	Adjust volume up / down
	
	
	

	Adjust speed up / down
	
	
	


Tip: The adjustment of the voice’s speed and volume using the Menu Bar is done through the "Voice Preferences" dialog box.
[bookmark: _Toc211499442]Task 2 – Further speech options
SuperNova and Dolphin ScreenReader also provide alternative voices and synthesisers you can use.
Spend no more than five minutes familiarising yourself with the steps to perform the following procedures.

1. How to choose an alternative voice using the Button Bar and the Menu Bar?

2. How to change to an alternative synthesiser language using the Button Bar and the Menu Bar? Depending on your setup, you may only have one language available with your default synthesiser.

3. How to change to an alternative synthesiser? This action can only be carried out through the "Voice Preferences" dialog box or with the use of a hotkey.

Did you find a particular voice you liked? Are there any important steps worth noting during these processes?

	Answer:





[bookmark: _Toc211499443]Task 3 – Fixing mispronunciations
You also learnt in this lesson that you can correct the mispronunciation of words by using the SuperNova and Dolphin ScreenReader exceptions dictionary. It is important to note that the exceptions you create are applied to a specific voice and not to a synthesiser.
Please review the following words and abbreviations and add them into your exceptions dictionary if they are not pronounced correctly.
Sample word list
· Coronavirus: pronounced "corona virus" but may be pronounced "coron avirus".
· ETA, pronounced "E.T.A." or "Estimated time of Arrival" but may be pronounced "eta".
· Findmypast, is part of a web address and is pronounced "find my past" and not a strangely spoken compounding of the word.
· Synthesiser, may be pronounced strangely using a US English voice, as it does not adjust for the UK English spelling. You can correct this by creating an exception that set "synthesiser" to be pronounced "synthesizer".
When creating exceptions in practice, it is also important to consider the single, possessive, and plural forms. For example, if you were to create an exception for "synthesiser", then you should add three exceptions into the dictionary.
These are:
· Synthesiser
· Synthesiser’s
· Synthesisers
Also remember when adding abbreviations that you should restrict them to case. For example, setting "AT" to "Assistive Technology" could have a significant impact for the user if set to occur with every occurrence of the "at" word.
Steps to add an exception
To add a word into the Dictionary:
1. Open the SuperNova or Dolphin ScreenReader Control Panel.
2. Open the "Speech" menu and choose "Voice Preferences" (ALT + S, P).
3. Open the "Voice and Language Configuration" tab and in the "Voice exceptions" group, ensure your preferred voice is selected and then choose the "Edit" button.
[image: Image of the Exceptions dialog box.]
4. Select the "Add" button and in the "Add exception" dialog box that appears, enter the Source Word and the Replacement Word. Note that you may need to misspell the replacement word for speech to announce the word in an appropriate manner. Use the "Speak" button to check pronunciation.

[image: Image of the Add Exceptions dialog box.]
5. Use the further options to determine when the rule is applied. For example, you can make the rule case sensitive to ensure words like "AT" is managed differently to "at".
6. When done, select the "OK" button.
You are good to go! The mispronunciation rule you have added into your Exceptions Dictionary will now be in use.
[bookmark: _Toc211499444]Task 4–Speech verbosity
You also learnt in this lesson that Verbosity controls the amount of information the screen reader tells you about the object that has focus. 
SuperNova and Dolphin ScreenReader contain four default Verbosity Schemes: Minimum, Low, Medium, and High.
Please fill in the missing words by stating what additional information is spoken when you use each Verbosity Scheme to open the File menu in the SuperNova Control Panel. Please also answer the subsequent questions.
Tip: If you are using the Default NumPad Hotkey Set, press CAPS LOCK + EQUALS to cycle through the Verbosity Schemes. If you are using the Laptop Universal Hotkey Set, press CAPS LOCK + V.
Output with each Verbosity Scheme
When I open the File menu in the SuperNova Control Panel by pressing ALT + F with a Minimum Verbosity Scheme, speech says:

File, New.

When I repeat this exercise using the Low Verbosity Scheme, speech says:

File __________, New __________ (34).

When I repeat this exercise using the Medium Verbosity Scheme, speech says:

File __________, New __________, __________, 1 of 8 (35).

And, when I repeat this exercise using the High Verbosity Scheme, speech says:

File __________, New __________, __________, 1 of 8, use arrow keys to select item, __________ to accept (36).

What Verbosity Scheme would you recommend to the following users?

[image: A cheerful man wearing headphones, looking away from laptop screen.]
I can see the screen using magnification and typically use the mouse to work in my apps. I find speech regularly talks too much.

	Answer (37):










[image: A cheerful, mature woman sat at a desk.]I am new to Windows, and I am often unsure what keypress I must perform to activate the objects that have focus.

	Answer (38):






[image: Man wearing dark glasses, reading a braille document.]

Although, I am unable to see the screen, I only use a few apps in Windows, and I am very familiar with their interface and how to navigate them using the keyboard. I like the reassurance that comes from being told what type of object has focus but don’t need help on how to interact with the object.

	Answer (39):













[image: A man wearing dark glasses and holding a white cane.]I am an experienced keyboard user and use a wide range of apps in Windows. As the apps I use are varied, I benefit from knowing how many items are available and the shortcut keys to menu items.

	Answer (40):





[bookmark: _Toc211499445]Task 5 – Typing
Finally, in this lesson you also learnt to configure SuperNova and Dolphin ScreenReader to echo each character you type, each character and word you type, each word you type, or to say nothing as you type. 
Of course, the choice people adopt can depend on several factors, including the task they are completing such as entering in a code, their typing ability, and their ability to view what they are typing on the screen.
Please spend no more than five minutes reviewing the different typing modes and consider the typing speed that would encourage you to change from echoing each character you type to echoing each word you type.
What do you think should occur if you have Character Echo set to "None" and you use the Arrow Keys to move through a document? Does speech read the text or is speech silent?

	Answer (41):





Test your assumption to confirm it is correct.
Remember, you can cycle between the different typing modes with a hotkey. Press CAPS LOCK + SEMI COLON or, if you are using the Laptop Universal Hotkey Set, press CAPS LOCK + 2.

Lesson 8
[bookmark: _Toc211499446]Exercise 8
[bookmark: _Toc211499447]Task – Capital announcements
You learnt in this lesson that you can configure SuperNova and Dolphin ScreenReader to indicate capitals in a variety of ways.
Using this information, please configure SuperNova to perform the following tasks to find the answers to the stated questions.
Questions
1. With "Increase voice pitch for spelt capitals" turned off, what does speech say when you are navigating a document character by character and a capital letter is encountered?

	Answer (42):





2. With "Increase voice pitch for spelt capitals" turned off, what does speech say when you are navigating a document word by word and a word with an initial capital letter is encountered?


	Answer (43):





3. What steps do you follow to configure SuperNova to announce capitals when reading lines? 

	Answer (44):





4. What steps do you follow to set capitals to be indicated with an audible beep sound? How many audible beep sounds are available?

	Answer (45):






Lesson 9
[bookmark: _Toc211499448]Exercise 9
[bookmark: _Toc211499449]Bold, italic, and underlined text
You learnt in this lesson that you can automate the announcement of text style changes plus other document elements using Text Style Announcements.
Using Microsoft Word or other supported rich text editor such as WordPad, please complete the following task.
Do the following:
1. Open a word processor and insert a few lines of sample text. If you are using Microsoft Word, you can type "=rand()" (without the quote marks) and press ENTER to insert some sample text.
2. Select a word and make it bold.
3. Move to a new line, select a word, and make it italic.
4. Move to a new line, select another word, and make it underlined.
Now, position the cursor beside a character that is bold and using the Character Speak Key, how many times must you press the key to discover the font attributes of the character?

	Answer (46):





Next, use the "Text Style Announcements" options to automate the announcement of the bold, italic and underline font style changes in your sample document. Is the format change announced before or after the change?

	Answer (47):





Finally, after your assessment, turn off the automatic announcement of bold, italic, and underlined text style changes.

Lesson 10
[bookmark: _Toc211499450]Exercise 10
[bookmark: _Toc211499451]Task 1 – Speak keys
You learnt in this lesson about SuperNova and Dolphin ScreenReader Speak Keys. You can use Speak Keys to read elements of the screen. A list of the most popular Speak Keys is documented in the lesson. You will also learn how to easily retrieve a list of Speak Keys in the Appendix to this workbook.
Please spend no more than five minutes using Speak Keys to do the following:
· Read the current character, word and line in a sample Microsoft Word document and consider the additional output when the keypress is pressed multiple times.
· Read the Status Bar in the SuperNova or Dolphin ScreenReader Control Panel.
· Read the focus and read the shortcut key for an item in the "File" menu of the SuperNova or Dolphin ScreenReader Control Panel.
· Read the current date and time.
· If you are using a laptop computer, review your current battery status. 

[bookmark: _Toc211499452]Task 2 – Read from here
You also learnt in this lesson that SuperNova and Dolphin ScreenReader include a continuous reading mode called "Read from here".
You can start and stop "Read from here" using the following keyboard commands.




Hotkeys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Start Read from here
	NUMPAD PLUS
	CAPS LOCK + DOWN ARROW

	Pause and Unpause reading
	SPACEBAR
	SPACEBAR

	Stop Read from here
	ESCAPE (or CONTROL)
	ESCAPE (or CONTROL)

	Start and stop Read from here using the mouse
	MIDDLE MOUSE BUTTON
	MIDDLE MOUSE BUTTON


[image: A young woman wearing dark glasses and holding a white cane.]Please answer the following email enquiry about "Read from here"? You should ensure you test your scenario before documenting the answer.

Email 
From:	r.f.here@work.com
To:		support@yourdolphin.com 
Sent:		01 January 2022
Subject:	Read from here enquiry
Hi,
I am using SuperNova Magnifier & Screen Reader and my responsibilities at work have recently changed. I have been asked to check documents are correctly using Heading Styles and that documents do not contain spelling errors.
I regularly read through such documents using "Read from here" and wonder if it is possible for me to be told about the heading styles and spelling errors flagged by Microsoft Word as I listen to the document being read aloud. If it is possible, where do I need to go to make such changes?
Thank you for any help you can offer.
Regards,
Rachel

	Answer (48):









Lesson 11
[bookmark: _Toc211499453]Exercise 11
[bookmark: _Toc211499454]Task – Enable Virtual Braille Display
In this lesson you learnt that Braille displays are expensive pieces of equipment. This means it is not always possible to review the Braille features provided with SuperNova and Dolphin ScreenReader.
To address this, Dolphin includes a Virtual Braille Driver, which you can select and use alongside the On-screen Braille monitor to gain an understanding of the output that may come from a Braille display.
Please follow the steps below to enable, activate and view the output from the Virtual Braille Display. 
Enabling the Virtual Braille Display
Do the following:
1. Open the SuperNova or Dolphin ScreenReader Control Panel.
2. Open the "General" menu and select "Advanced Options" (ALT + G, A).
3. Select the "SAM Setup" button. This will open the "SAM configuration" dialog box. You may need to ALT + TAB to bring this window into focus.
[image: Image of the SAM Configuration dialog box showing the Virtual Braille Display selected with its status unchecked and a unit value of zero.]
4. Select "Virtual Braille Display" from the list of available drivers and choose the "Configure" button. This will open the "Virtual Braille Display" properties dialog box.
[image: Image of the Virtual Braille Display properties dialog box with the Enable the virtual Braille display check box unchecked.]
5. Select the "Enable the Virtual Braille Display" check box and choose the "OK" button.
In the list of drivers, the Virtual Braille Display driver will now be marked with a value of "1" to indicate a device has been successfully detected.
6. Finally, in the list of drivers, choose the "Virtual Braille Display" item and either press SPACEBAR or click it to select it as a device you wish to use. Selection is indicated with a ticked check box.
[image: Image of the SAM Configuration dialog box with the Virtual Braille Display selected and with a unit value of one.]
7. When done, select the "Close" button.
The Virtual Braille Display will be automatically detected by SuperNova and Dolphin ScreenReader. The name of the device is the "Virtual on-screen Braille display".
Once you are happy the Braille display is selected, turn on the "Show Braille on screen" option to view the output that is sent to the virtual display. 
Remember, the On-screen Braille monitor is a visual aid to assist colleagues wishing to see what is appearing on the Braille display and that its appearance can be altered through the "Braille Advanced Options" dialog box.
Please spend five minutes familiarising yourself with the options for the On screen Braille monitor in the "Braille Advanced Options" dialog box (ALT + B, A).

Lesson 12
[bookmark: _Toc211499455]Exercise 12
[bookmark: _Toc211499456]Task – Dolphin Cursor
You learnt in this lesson about the Dolphin Cursor and its use for reading text from elements of the screen where an app’s focus cannot go and its use for reading webpages.
For most, the main use of the Dolphin Cursor is to enable users to browse the web. In this respect, the Dolphin Cursor includes more advanced features to help get around a webpage more quickly, enables users to search a webpage, and copy data from the page with keyboard commands.
Please answer the following queries.
[image: A mature woman wearing glasses and headphones and using a computer.
]

"I use the Dolphin cursor to navigate webpages and when I visit my news outlet website, I’m presented with a series of links at the top of the page that I need to traverse before I can reach the main article. Speech tells me that the main article starts at Heading level one. Is there a way I can quickly navigate to this Heading? If yes, what key should I press?"

	Answer (49):




[image: A mature man, wearing glasses holding a coffee cup.]
"I use the Dolphin Cursor to navigate webpages and frequently visit my favourite football teams fixture list. Unfortunately, the webpage is a plain page without structure and does not separate months into headings, which makes navigating the webpage very time consuming. Is there a Dolphin Cursor feature that can help me find the month I am seeking?"

	Answer (50):




[image: A mature man wearing dark glasses and holding a white cane.]

"I navigate my websites using the mouse but do enjoy reading articles using the Dolphin Cursor and the Arrow Keys. Can I use the mouse to move the Dolphin Cursor to parts of a webpage? How is this done?
What other speech features might benefit me as I navigate websites using the mouse?"

	Answer (51):








Lesson 13
[bookmark: _Toc211499457]Exercise 13
[bookmark: _Toc211499458]Task 1 – Creating an Application Settings file
You learnt in this lesson that Application Settings enable you to automatically apply SuperNova and Dolphin ScreenReader settings to an app and that you can further control settings through Situation Settings.
Please create an Application Settings file for an app such as NotePad, Word Pad or Microsoft Word. 
Here is a reminder of the steps to follow.
Creating Application Settings
To do this:
1. Run a target program such as NotePad, WordPad, or Microsoft Word.
2. Open the SuperNova or Dolphin ScreenReader Control Panel by pressing LEFT CONTROL + SPACEBAR. It is important to use the keyboard command to open the Control Panel as it ensures the correct app is identified by SuperNova and Dolphin ScreenReader.
3. Open the "File" menu and then open the "New" submenu (ALT + F, N).
4. Choose "Application Settings". This will open the "New Application Settings " dialog box.
[image: Image of the New Application Settings dialog box with Use an existing settings file option selected.]
5. Choose "Create a new settings file" and select the "OK" button. 
[image: Image of the New Application Settings dialog box with Create new settings file option selected.]
6. Give the new Application Settings file a name, 
[image: Image showing Word Settings in the settings file name box.]
7. Choose whether to create an empty settings file, which is just the internal factory defaults, or copy an existing settings file (recommended) and then Select the "OK" button.
And that is it. Your new Application Settings file will now be in use and saving each SuperNova or Dolphin ScreenReader setting you change while you are in your target app.
To test this:
1. Make changes to SuperNova or Dolphin ScreenReader while the app has focus, for example, change the Magnifier Size, Magnifier View, or Speech Verbosity.
2. Switch to the desktop (e.g., press WINDOWS KEY + D). This should result in your SuperNova OR Dolphin ScreenReader default settings being automatically applied.
3. Switch focus back to your target app and your new Application Settings should be automatically applied.
Your Application Settings file will be in use each time you run the app and SuperNova and Dolphin ScreenReader will automatically update the file with any setting changes you make.
[bookmark: _Toc211499459]Task 2 - Creating Situation Settings
Continuing on from the previous exercise, please create a Situation Setting for the Save As dialog box:
1. Run the target app used in the previous exercise and ensure your Application Settings file is in use.
2. Open the "Save As" dialog box. If you are using Microsoft Word, you can open this dialog box by pressing F12.
3. Open the SuperNova or Dolphin ScreenReader Control Panel by pressing LEFT CONTROL + SPACEBAR. It is important to use the keyboard command to open the Control Panel as it ensures the current situation is identified by SuperNova and Dolphin ScreenReader.
4. Open the "File" menu and then open the "New" submenu (ALT + F, N).
5. Choose "Situation Settings".
[image: Image of the New Situation Settings dialog box with Use an existing Situation option selected.]
6. Choose "Create new Situation" and select the "OK" button.
[image: Image of the New Situation Settings dialog box with Create New Situation option selected.]
7. In the dialog box that appears, give the new Situation Setting a meaningful name and select the "OK" button. 
[image: Image of the Enter a name dialog box with the word Save As presented in the name box.]
8. Although it is possible to expand the range of windows your Situation can apply to using wild characters in the window name, in most cases this is unrequired, and the default text should be unchanged. Select the "OK" button to proceed.
[image: Image of the Windows Name dialog box with the Save As window title unchanged in the edit box.] 
And that is it! Your Situation Setting is created and will now be in use. You can check the Situation Setting currently in use by reading the SuperNova or Dolphin ScreenReader Control Panel Status Bar.
You can test your Situation Setting by choosing different SuperNova or Dolphin ScreenReader settings whilst focus is on the dialog box, for example, change the Magnifier Size, Magnifier View or change the Character Echo to an alternative setting.
Then, simply close the dialog box. Your settings should revert to your previous Application Settings. Open the dialog box again and your alternative settings are automatically applied once more.
[bookmark: _Toc211499460]Task 3 – Edit, Import and Export options
To finish this exercise, spend five minutes reviewing the Edit, Import and Export options available for Application Settings and Situation Settings in the "File" menu of the SuperNova or Dolphin ScreenReader Control Panel. 
When ready, delete your Application Settings file.
Why are Situation Settings missing from the Import and Export submenu?

	Answer (52):





Lesson 14, 15 and 16
[bookmark: _Toc211499461]Exercise 14
[bookmark: _Toc211499462]Task 1 – Editions supporting scanners, cameras, and whiteboards
You learnt in these lessons that, depending on your SuperNova and Dolphin ScreenReader edition, you can:
· Convert printed material and image files to text.
· Magnify, read, and convert printed material using a camera.
· Magnify, read, and convert the output from another computer screen such as a teacher’s whiteboard using VNC. 
Please complete the following table.
Answer (53)
	Edition
	Scan and read function
	Connect & View function including OCR
	Connect & View function without OCR

	SuperNova Magnifier
	No
	
	

	SuperNova Magnifier & Speech
	
	
	No

	SuperNova Magnifier & Screen Reader
	
	
	

	Dolphin ScreenReader
	Yes
	
	No



[bookmark: _Toc211499463]Task 2 – Convert an image to text
Do the following:
1. Visit the Dolphin website (www.yourdolphin.com).
2. Copy the Dolphin Computer Access logo to the Clipboard. The logo is the first object on the webpage.
3. Use the "Scan and read" option from the SuperNova or Dolphin ScreenReader Control Panel "Media" menu to convert this clipboard image to text.
You should find, when the conversion is complete, a spurious "k" character appearing before the word "Dolphin". This occurs because the recognition engine is mistaking part of the logo as a letter k. 
It is important to remember that optical character recognition is not always 100% accurate. Shading, colours, and formatting can all impact on the success of the recognition process.
[bookmark: _Toc211499464]Task 3 – Connect and view the output from a digital camera.
If resources permit, do the following:
1. Connect your camera to your computer. If your computer has an inbuilt camera, then this can also be used for this simple exercise.
2. Select your camera in the SuperNova Connect & View "Settings".
3. Turn on "Connect & View" and experiment with the window size and position.
4. Ensure you are comfortable moving your mouse pointer between your desktop and camera window.
5. Take a picture.
6. Copy the image to the Windows Clipboard, turn off "connect & View", and paste the image into your word processor.
[bookmark: _Toc211499465]Task 4 – Connect to another Windows computer
If resources permit, do the following:
1. Visit the Dolphin website (www.yourdolphin.com).
2. Search for "whiteboard wizard" and visit the resulting product page.
3. Submit the form, open your received email, and download the installation files and support documentation.
4. Copy the installation file onto a test computer that is running Windows and sharing the same network.
5. Follow the instructions laid out in the lesson (or support documentation) to make a connection between SuperNova and your test computer.

Lesson 17
[bookmark: _Toc211499466]Exercise 15
[bookmark: _Toc211499467]Task – Review an image description using Ask AI.
In this lesson you learnt about the use of AI to provide meaningful descriptions for people with a visual impairment. You discovered the different methods you can use to access the "Ask AI" feature in SuperNova and Dolphin ScreenReader. These included through the Control Panel "Media" options, through Doc Reader, and using Layered Hotkey Mode.
Do the following:
1. Visit the Dolphin website (www.yourdolphin.com).
2. Copy the Dolphin Computer Access logo to the Clipboard. The logo is the first object on the webpage.
3. Use the SuperNova or Dolphin ScreenReader Control Panel "Media" options or Layered Hotkey Mode (CAPS LOCK + SPACEBAR, Q, C) to query the image copied to the Clipboard using "Ask AI".
4. Contrast the results from Task 15.1, where you converted the image using OCR technology.
Hopefully, you have discovered that AI can provide a much richer answer than OCR for certain tasks. However, It is important to emphasise to clients that Ask AI is not always accurate and, although, AI technology is improving exponentially, it can still have hallucinations.

Lesson 18
[bookmark: _Toc211499468]Exercise 16
[bookmark: _Toc211499469]Task – Review Profile options
In this lesson you learnt about Profiles and their application. Now, spend no more than five minutes reviewing the Profiles available with your SuperNova edition.
Tip: Users that use a Screen Reader Profile will discover many of the items in the Visual tab of the Button Bar disabled. Such users may benefit from hiding the Button Bar, which you can do in the "Control Panel Settings" dialog box (ALT + G, P).
If a person wants SuperNova to read the information on the Status Bar of the Control Panel, what key must they press when using the Default NumPad Hotkey Set and the Laptop Universal Hotkey Set?

	Answer (54):





[bookmark: _Hlk115779079]Lesson 19
[bookmark: _Toc211499470]Exercise 17
[bookmark: _Toc211499471]Task –EasyReader Premium subscription
You learnt in this lesson that EasyReader for Windows is available as part of the SuperNova and Dolphin ScreenReader installation package. After installation an EasyReader icon will appear on the desktop to provide easy access to the app.
EasyReader is a free app developed by Dolphin. People can download and install EasyReader on a variety of platforms including windows, IOS, and Android.
An EasyReader Personal and Education Plan is also available.  SuperNova and Dolphin ScreenReader users with an active Software Maintenance Agreement (SMA) or membership to the SuperNova Upgrade Program (SUP) can subscribe to the EasyReader Personal Plan free-of-charge.
Name three benefits users gain from the EasyReader Personal Plan?

	Answer (55):

1.

2.

3.




If a user is entitled to the EasyReader Personal Plan, then the steps they must follow to link their SuperNova or Dolphin ScreenReader to EasyReader is explained below. Please fill in the missing word.

1. Open the SuperNova or Dolphin ScreenReader Control Panel.
2. Open the "Media" menu or tab.
3. Choose "Books" and select __________ (56). The EasyReader app opens.
4. Login to the EasyReader App with a Dolphin Account or Google Account.

Workbook
[bookmark: _Toc211499472]Next steps
[bookmark: _Toc211499473]Course assessment
Congratulations on completing the SuperNova for Trainers Workbook.
We hope you have enjoyed working through the exercises and that the exercises have helped you to gain a good understanding of the products. 
Prior to taking the Course Assessment, please ensure you complete any remaining lessons.
If you would like to provide feedback on this workbook, please contact training@yourdolphin.com. All feedback is appreciated.

Workbook
1. [bookmark: _Toc94687091][bookmark: _Toc211499474]Appendix - Quick Reference  
[bookmark: _Toc211499475]SuperNova Help
As you have learnt throughout this workbook, SuperNova contains many hotkeys for accessing useful features or product settings. If you cannot recall a particular series of steps or keyboard command, then the SuperNova Help can help you find an answer. 
You can open SuperNova Help through the "Help" menu of the SuperNova Control Panel.
The Help window is a multi tab window providing easy access to:
· Ask a Question. This AI Help system requires Internet access and will produce answers from various Dolphin online help and training resources.
· Keyword Search. This help system provides results from local help files including the Manual, Hotkeys, and Application Help files.
· Manual. This help system provides access to the traditional HTML Help system, enabling you to explore and view topics of interest. The Welcome page describes the keyboard commands for navigating the Manual including, notably, CONTROL + T to view the Contents.
[bookmark: _Toc94687093][bookmark: _Toc211499476]Touchscreen gestures
[bookmark: _Toc28958578]Touchscreen terminology
The following table provides a description of touchscreen gestures and what the gesture means.

Gesture terminology
	Gesture
	How to do it

	Tap
	Tap the screen to perform an action, for example, tap a button to activate the button. Some gestures may require you to tap the screen with 1, 2, 3 or more fingers multiple times.

	Press and hold
	Press a finger on the screen and continue to hold the finger against the screen until the required action occurs.

	Swipe
	A flick of a finger across the screen.

	Slide
	A longer slower movement of a finger across the screen usually in a vertical or horizontal direction from the screen edge.

	Pinch
	Press two fingers on the screen and move them together, as if you are pinching them together.

	Stretch
	Press two fingers on the screen and move them away from each other, as if you are stretching them apart.


[bookmark: _Toc28958579]Touchscreen gestures to control SuperNova
The following table provides a list of the touchscreen gestures you can use to control SuperNova.
SuperNova touchscreen gestures
	Function
	Gesture

	Toggle magnification
	3-finger double-tap

	Increase magnification
	2-finger stretch

	Reduce magnification
	2-finger pinch

	Pan
	1 finger swipe

	Show / hide the SuperNova Touch Bar
	3-finger single tap

	Announce text under the finger position
	1-finger press and hold


More gestures.
In addition to the SuperNova touchscreen gestures, here are some more touchscreen gestures to help you get around Windows.
Windows touchscreen gestures
	Function
	Gesture

	Switch apps
	Swipe in from over the left edge with 1-finger.

	Open the App Menu. The App Menu shows commands like Save, Edit and Delete.
	Slide in from over the bottom edge with 1-finger.

	Close the open app
	Slide in from over-the-top edge with 1-finger and continue the motion, dragging the app down to the bottom of the screen.

	Open the context menu (this is the same as performing a right click on a selected item)
	1-finger double-tap, hold and release.

	Drag and drop objects around the screen, for example, when re-arranging the Start Screen or desktop.
	1-finger double-tap and hold, then slide to move the object. Lift finger to release.


[bookmark: _Toc28958580]For a full list of Windows touchscreen gestures, please visit the following Microsoft Support webpage – Touchscreen gestures in  Windows.
SuperNova Touch Bar
The SuperNova Touch Bar is a touchscreen toolbar that appears at the bottom of the screen when you do a 3-finger single tap. The Touch Bar gives you access to the most common SuperNova actions including turning magnification on and off, changing magnification size and turning the SuperNova Color Scheme on and off.
[bookmark: _Toc28958581]Typing on a touchscreen
SuperNova automatically shows an onscreen keyboard if you need to type and do not have a keyboard connected to the device. The onscreen keyboard appears at the bottom of the screen and uses large print high contrast keys.
You can also make the keyboard appear at any time by tapping the Keyboard button in the SuperNova Touch Bar or by tapping the Keyboard button in the Windows Notification area. To hide the keyboard, tap the large "X" button in the bottom right corner of the onscreen keyboard.
You can adjust the appearance of the onscreen keyboard in the Touchscreen Settings dialog box. You can reach this dialog box through the "General" menu of the SuperNova Control Panel.
[bookmark: _Toc28958582]Adjust touch sensitivity
You can adjust how sensitive SuperNova is to your taps and swipes on the touchscreen. 
For example, if you find that SuperNova is interpreting a double-tap gesture as two single-tap gestures, then you may need to increase the double-tap timeout". In the same way, if you find that when attempting to drag-and-drop a desktop icon that the icon is not being picked up, then you may need to increase the double-tap timeout or the pass-through timeout".
You can adjust the touchscreen parameters in the Touchscreen Settings dialog box. You can reach this dialog box through the "General" menu of the SuperNova Control Panel.
[bookmark: _Toc94687094][bookmark: _Toc211499477]Popular Windows keyboard commands
[bookmark: _Toc28958610]Menu bar hotkeys
	Function
	Hotkey

	Move focus to the menu bar
	ALT

	Move focus across the menu bar
	LEFT ARROW or RIGHT ARROW

	Open the menu item that has focus
	DOWN ARROW or ENTER

	Move to and open a menu bar item
	ALT + Underlined letter

	Move through an open menu
	DOWN ARROW or UP ARROW

	Open a submenu
	RIGHT ARROW or ENTER

	Close a submenu
	LEFT ARROW or ESCAPE

	Select a menu item
	ENTER


[bookmark: _Toc28958611]Dialog box hotkeys
	Function
	Hotkey

	Move to the next control
	TAB

	Move to the previous control
	SHIFT + TAB

	Press a button, toggle a check box, or select an option
	SPACEBAR

	Move directly to a control
	ALT + Underlined letter

	Open the next tab in a multi tab dialog box
	CONTROL + TAB

	Open the previous tab in a multi tab dialog box
	CONTROL + SHIFT + TAB

	Cancel
	ESCAPE


[bookmark: _Toc28958612]Desktop hotkeys
	Function
	Hotkey

	Open Start menu
	WINDOWS KEY

	Go to the desktop
	WINDOWS KEY + D

	Go to the taskbar
	WINDOWS KEY + T

	Go to the Notification Area
	WINDOWS KEY + B


[bookmark: _Toc28958613]General Windows 10 & 11 hotkeys
	Function
	Hotkey

	Open Start Menu
	WINDOWS KEY

	Open Task View
	WINDOWS KEY + TAB

	Switch to application
	ALT + TAB

	Go to Lock Screen
	WINDOWS KEY + L

	Create a new virtual desktop
	CONTROL + WINDOWS KEY + D

	Switch to the next virtual desktop
	CONTROL + WINDOWS KEY + RIGHT ARROW

	Switch to the previous virtual desktop
	CONTROL + WINDOWS KEY + LEFT ARROW

	Close current virtual desktop
	CONTROL + WINDOWS KEY + F4

	Open Devices
	WINDOWS KEY + K

	Open Settings
	WINDOWS KEY + I

	Open the Tools menu
	WINDOWS KEY + X

	Snap window to top of screen (repeat to maximize window)
	WINDOWS KEY + UP ARROW

	Snap window to bottom of screen (repeat to minimize window)
	WINDOWS KEY + DOWN ARROW

	Snap window to left of screen (combine with snap to top/bottom to place window in quadrant)
	WINDOWS KEY + LEFT ARROW

	Snap window to right of screen (combine with snap to top/bottom to place window in quadrant)
	WINDOWS KEY + RIGHT ARROW


	
For a full list of Windows keyboard commands, please visit the following Microsoft Support webpage – Windows keyboard commands.
[bookmark: _Toc23946821][bookmark: _Toc94687095][bookmark: _Toc211499478]Video Tutorials
You can view a full list of the SuperNova Video Tutorials on the YourDolphin.com website. You can also view a list of videos on Dolphin’s YouTube channel.


Workbook
[bookmark: _Toc211499479]Appendix – Exercise answers 
Exercise 1
1. SuperNova Magnifier & Screen Reader.
2. SuperNova Magnifier & Speech.
3. Dolphin ScreenReader.
4. SuperNova magnifier.

Exercise 2
5. Title Bar.
6. Menu Bar.
7. Button Bar.
8. Status Bar.
9. ALT key.
10. Menu Bar.
11. Button Bar.
12. TAB.
13. Button Bar.

Exercise 3
14. Control Panel.
15. Keyboard commands.
16. Touchscreen gestures.
17. Keyboard commands.
18. Although subjective, and it must be recognised that many factors can influence the decision such as screen resolution, font size, familiarity with apps, etc. As a rule, a person working at 6x or higher will benefit from introducing speech support. 
19. A.

Exercise 4
20. The appearance of Hooked Areas does not require primary magnification to be enabled. 
21. 6.
22. DELETE.

Exercise 5.
23. High Contrast Yellow on Blue, available through the "Other Schemes" submenu. You must press LEFT CONTROL + NUMPAD 0 to toggle Colour Schemes on and off.
24. Highlighting.
25. De-select the "Use custom pointer in magnified areas only" check box in the "Mouse Pointers" dialog box.
26. Yes, they continue to function when magnification is turned off.

Exercise 6.
27. Productivity.
28. Extend.
29. Span mode.
30. Side by side application mode.
31. Presentation mode.
32. Mouse buffer.
33. CAPS LOCK + MIDDLE MOUSE BUTTON

Exercise 7.
34. File menu, New has submenu.
35. File menu, New has submenu, shortcut n, 1 of 8. 
36. File menu, New has submenu, shortcut n, 1 of 8, use arrow keys to select item, ENTER to accept.
37. Minimum.
38. High.
39. Medium.
40. Low.
41. When Character Echo is set to "None", speech will continue to read the characters and lines as you navigate through a document using the Arrow Keys. This is because Character Echo only relates to the inputting of text.

Exercise 8
42. Caps.
43. Capital.
44. Select "Announce capitals when reading lines" check box in the "Speech General Preferences" dialog box.
45. Select "Use beeps for capital announcements" check box in the "Speech General Preferences" dialog box. There are twenty beep sounds from which you can choose.

Exercise 9
46. Three times.
47. Style changes are announced before the change.

Exercise 10
48. You can automate the announcement of Headings, spelling errors and other formatting parameters when using Read from here. You can do this by going to the "Text Style Announcements" dialog box, opening the "Read from here" tab and then choosing the options you require announcing.

Exercise 12
49. Yes, by pressing 1 on the main keyboard.
50. Yes, by using the Dolphin Cursor Find feature.
51. You can move the Dolphin Cursor to the text that appears below the pointer by pressing the MIDDLE MOUSE BUTTON. You can enhance this further by enabling "Click and Read from here", which will move the Dolphin Cursor to the pointer position and then automatically start reading from this point onwards. You can also enable the "Announce text under the mouse pointer" option in the "Speech General Preferences" dialog box to gain additional speech support when hovering the pointer over text on the screen.

Exercise 13
52. Situation Settings are a subset of Application Settings files and are stored within the same file.

Exercise 14
53. See table below.

	Edition
	Scan and read function
	Connect & View function including OCR
	Connect & View function without OCR

	SuperNova Magnifier
	No
	No
	Yes

	SuperNova Magnifier & Speech
	Yes
	Yes
	No

	SuperNova Magnifier & Screen Reader
	Yes
	Yes
	No

	Dolphin ScreenReader
	Yes
	No
	No



Exercise 16.
54. Default NumPad Set is NumPad 2. The Laptop Universal Hotkey Set uses CAPS LOCK + PAGE DOWN.

Exercise 17
55. EasyReader Premium includes synchronisation of books, reading position, bookmarks and study notes, saved clipboard text, library credentials and reading preferences across devices.
56. My Books.
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